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Adobe Photoshop 6.0 software delivers the next generation of image-editing capabilities with powerful new
features that offer something for every user. Now you can:
• Expand beyond pixels. Adobe Photoshop 6.0 redefines desktop image editing with integrated vector-drawing
support that extends your creative range. With this support, you can incorporate editable vector shapes and
text into your images, and then output these resolution-independent graphics and text with your image data.
You can produce an Adobe PDF file for high-end printing or for output directly to a PostScript® printer.
Photoshop 6.0 also opens new artistic options with content layers, layer styles, warping controls, and other
creativity-inspiring features.
• Produce superb Web graphics. Adobe Photoshop 6.0 expands its Web toolkit to provide more timesaving,
production-oriented features, including Adobe ImageReady™ 3.0 for advanced Web-production tasks. From
offering slicing tools directly in Photoshop to introducing efficient new rollover styles in ImageReady,
Photoshop 6.0 fine-tunes the toolkit considered essential by Web designers worldwide.
• Master the power of Photoshop quickly. As the world-standard image-editing solution, Adobe Photoshop is
renowned for its power and breadth. One challenge it faces, though, is how to make this power more accessible to everyone. Photoshop 6.0 introduces hundreds of subtle enhancements—from on-canvas text entry to
an intuitive new context-sensitive tool options bar—that make it easier for you to get to work quickly and use
its features more fully. No matter how long you’ve been using Photoshop, for ten days or ten years, you’ll
appreciate the freedom to focus on being your best.
In addition, Photoshop 6.0 integrates tightly with Adobe’s family of professional graphics programs for Web,
print, and dynamic media, including Adobe Illustrator®, Adobe InDesign™, Adobe GoLive®, Adobe LiveMotion™,
Adobe Acrobat®, Adobe After Effects®, and Adobe Premiere®. With the award-winning tools in Photoshop, you can
produce the highest-quality images for any medium.
This document introduces the new features in Adobe Photoshop 6.0 and illustrates how Photoshop continues
to provide the world’s leading image-editing solution. The first three sections explain its new creativity, Web,
and productivity features. The final sections describe Photoshop 6.0’s pricing and availability, system requirements, and extra value included in the box.

Expand beyond pixels
Adobe Photoshop 6.0 transforms traditional image editing by integrating tools for creating and outputting
crisp, editable vector shapes and text. With these new vector tools, you can incorporate resolution-independent vectors into your images to produce designs for magazine covers, brochures, packaging, information
graphics, and a wide spectrum of other print and Web materials. This new vector support lets you achieve a
range of design effects more efficiently and cost-effectively than has previously been feasible from the desktop. In addition, Photoshop 6.0 provides content layers and layer styles to streamline layer design, new warping controls for isolating and making fine adjustments to targeted image areas, and expanded support for
Adobe PDF files and 16-bit images.
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Superb vector shape support
Photoshop 6.0 delivers vector-shape tools for quickly creating a wide variety of basic shapes. The new rectangle, rounded rectangle, ellipse, polygon, line, and custom shape tools produce shapes that you can use as
shape layers, as vector masks (called layer clipping paths), or for painting pixels. When you select a drawing
tool, a context-sensitive tool options bar appears at the top of the Photoshop workspace, so you can select
drawing options. You can, for example, quickly set options for a rectangle, such as whether it’s unconstrained, square, fixed size, proportional, or drawn from the center. In addition, you can select a layer style,
blending mode, and opacity setting for a shape layer before you start drawing. These options make it efficient to incorporate vectors into your designs.
3
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1 Select a vector-shape
tool.
2 Specify whether
you’re creating a
shape layer, a work
path, or a fill region.
3 Specify drawing
options for the shape
you’re creating.
4 Select a layer style
that’s applied as you
draw the shape.
5 Instantly create a
complete shape, such
as the Web graphic
pictured here.
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Add, Subtract, Intersect, and
Exclude buttons for quickly
combining shapes

Photoshop 6.0—like Adobe Illustrator and other Adobe programs—also provides pathfinder operations for
quickly combining basic shapes into hard-to-draw shapes. These operations includes Add, Subtract, Intersect, and Exclude. You can then edit the shapes created—or any other shape you’ve drawn with the basic
shape, pen, or freeform pen tool—at any time by selecting and rearranging path points with the new directselection tool. Or, you can add and subtract points with the add-anchor-point and delete-anchor-point
tools, and then modify these points with the direct-selection tool.

New direct-selection tool for
easily editing vector graphics

Quickly create combination
shapes using the new vector
drawing tools and the buttons
for boolean operations, such as
Add or Subtract.
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Once you’ve created shapes you want to use over again or share with colleagues, you can save them as custom shapes. Photoshop automatically stores custom shapes in a default custom shape library. Alternatively,
you can use the Preset Manager to save custom shapes in separate custom shape libraries, and then load
those libraries with a single click from the Preset Manager or the context-sensitive tool options bar. Shape
libraries are portable, so workgroups can easily design, share, and add onto them. Photoshop 6.0 also ships
with a selection of custom shape libraries.

Select custom shapes from the libraries
included with Photoshop 6.0, or create and
store your own custom shapes.

Finally, the new vector-drawing tools are straightforward to automate because their activities are
scriptable—so you can include them in the actions you create with the Actions palette. For more details
about the context-sensitive tool options bar, see “Streamlined interface” later in this document. For details
about the Preset Manager, see “Preset Manager” later in this document.
Vector text support
With Photoshop 6.0, you can easily combine vector text with images, and then output sharp text edges with
your image data to produce high-quality results. What’s more, Photoshop includes extensive new type controls to help you produce the best-looking text possible. (For details, see “Expanded text options” later in
this document.) Photoshop 6.0 also provides text-warping controls, so you can freely twist and warp text to
produce cool effects. Best of all, the text remains editable no matter how you manipulate it. The combination of crisp vector text and raster image data opens new creative options for your design work.

Combine vector text with images
and output flawless results. For
example, design an image in which a
model’s hair flows over crisp text.
Also warp text and edit it later.

Vector-based masks
One of the most powerful ways to apply Photoshop’s new vector-drawing capabilities is by creating editable
shapes to clip out image areas. You can modify these layer clipping paths just as you would any other vector
path using the direct-selection, add-anchor-point, and delete-anchor-point tools. To produce a mix of hard and
soft masking edges, simply combine layer clipping paths and raster masks on the same layer. Or, produce fabulous editable effects by filling layer clipping paths with dynamic content, such as color and tonal adjustments, solid colors, patterns, and gradients. (For details, see “Content layers” later in this section.)
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Photoshop 6.0 also includes interface enhancements, such as a context-sensitive menu that makes it easy to
stroke, fill, transform, and remove layer clipping paths.
Select this button to create a
work path, which you can then
convert to a layer clipping path.

Easily create and edit layer clipping paths (vector masks) using
the new vector shape tools and
the pen and freeform pen tools.

Control-click (Mac OS) or rightclick (Windows) a layer clipping
path to choose commands that
affect that mask.

Resolution-independent vector output
Creating vector graphics and text to incorporate into your images is only one part of a complete workflow.
You also need to be able to output clean-edged vectors along with your raster image data—all with the
highest-quality printed results. Consider the example of an image in which a model’s hair flows over the top
of crisp text. In the past, preparing this file for output from a desktop system would have involved multiple
software programs and been prohibitively labor-intensive. To get the final result you wanted, you would
instead have relied on expensive, high-end prepress systems. Now you can quickly and easily achieve professional printed results directly from Photoshop 6.0. In fact, Photoshop 6.0 offers a choice of workflows: You
can print images containing resolution-independent shapes and text directly to any PostScript output device. Or, you can output resolution-independent shapes and text with your images in compact PDF files.
Any service provider with Adobe Acrobat® InProduction™ (or other Acrobat prepress plug-ins) can then
prepare those PDF files for high-end printing. From creation to final printed results, Photoshop 6.0 delivers
complete support for combining sharp-edged vector objects with your raster images.
Content layers
In Photoshop 6.0, you can create two kinds of content layers: adjustment layers and fill layers. Adjustment
layers have long been an efficient way to apply color and tonal adjustments to one or more layers at once,
without permanently altering an image’s pixels. Fill layers make it equally as quick to apply editable gradients, patterns, and solid colors to layers. Photoshop 6.0 now lets you change one type of content layer for
another without having to delete the original layer or layer mask and set up a new one. For example, you
could apply a Levels adjustment, and then decide that a Curves adjustment would produce a better result.
With Photoshop 6.0, you simply switch one content layer for another, and modify its settings.

If you set up a content
layer and then decide
you want to apply a
different type of
adjustment…

…you can easily swap it
out—without having to
start over with a new
adjustment layer.
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The new gradient, pattern, and solid fills work well with vector shapes and
layer clipping paths for similar reasons: It’s so easy to experiment with how
they look. You could create a red square, for example, and then refill it with a
gradient or pattern for a different look. This dynamic editability makes it
more fun and engaging to test different creative options as you assemble
an image.

Design a gradient map as an adjustment
layer. Access gradients for your design in
a single click: Any gradient libraries saved
in the Preset\Gradients folder are available in the Gradient Map dialog box.

In addition, Photoshop 6.0 includes a new adjustment layer type, called
gradient map, which takes an image’s luminance values and maps them to a
gradient. You can use this image adjustment feature to turn black-and-white
or color originals into subtle multi-toned images. Gradient map supplements
the adjustment layer types that were previously available, which include
Levels, Curves, Color Balance, Brightness/Contrast, Hue/Saturation, Channel
Mixer, and Posterize.

Layer styles
Photoshop 6.0 presents an intuitive new layer effects interface, a new selection of effect options, and new
support for saving your layer effect designs as layer styles for on-going use. First introduced in Photoshop
5.0, layer effects offer a fast way to apply drop shadows, glows, bevels, embossing, and other effects to layers.
Once applied, these effects update automatically when you change the content of the layer. They are particularly useful for designing editable type treatments or creating Web buttons and banners.
Now layer effects are easier than ever to define and apply. The new Layer Styles dialog box shows at a glance
which effects are applied to the currently selected layer. To add effects to a layer, you simply check each one
you want in the list. Then click each effect name to display its associated options and specify settings for it.
Photoshop 6.0’s layer effects even support larger sizes, so you can use them with high-resolution images.

A
B
G
F

C
E
D

A Click the style label to display thumbnail representations of all of your available layer styles.
B Specify blend settings as part of a layer effect design, and then save those settings in a
layer style.
C Click a layer effect name to make its options appear in the Layer Style dialog box.
D Check a layer effect to include it in your design.
E Produce eye-catching metallic and glow effects with the new satin layer effect.
F Preview your layer effect design as you create it.
G Click New to save the current combination of settings as a layer style for on-going use.
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Photoshop 6.0 also introduces new layer effects—strokes, overlays (solid color, pattern, and gradient), and
satins—as well as dozens of enhancements to existing layer effects. Plus, it adds general and advanced
blending and transparency settings, which you can save with a layer style. And, finally, it adds contours to
the options for many layer effects, which you can use to modulate the shape of a bevel, the style of a satin
effect, and so on. Here’s a brief overview of the new layer effect options:
• Stroke Apply strokes with widths of up to 250 pixels to vector or raster objects. (Photoshop intelligently
determines whether to apply a vector or raster stroke based on the type of object.) Specify where the stroke
is positioned, what blend mode and opacity settings it uses, and whether it’s filled with a solid color, a gradient, or a pattern.
• Solid, pattern, and gradient overlays Create separate solid, pattern, and gradient fills. Or, combine these fills
along with varying opacity and blend mode settings to produce extraordinary visual results.
• Satin Create an interference pattern that interacts with the shape of a layer to produce eye-catching metallic
and glow effects.
• Blending options Specify general and advanced blending options that control how a layer style interacts
with the underlying image layers. For example, set a layer style to partially or completely knock out the
underlying image layers. (In partial knockouts, the effect blends with layers lower in the stacking order.)
Knockouts work particularly well for creating goodlooking transparent button effects. Or, restrict blending
to certain channels, so that the layer style interacts with some color components of the image but leaves
others untouched.

Here’s a layer style example
that uses the new satin and
stroke effects, plus a solid
color overlay and drop
shadow.

Specify a contour to control
the gloss effect.

Here’s a sampling of some of the enhancements made to existing layer effects:
• Drop Shadows/Inner Shadows You can now set spread and noise values for drop shadows, and choke and
noise values for inner shadows.
• Inner and Outer Glows New glow options include noise, jitter, and spread (outer glow) or choke (inner
glow). Plus, you can now specify a gradient color for both inner and outer glows.
• Bevel and Emboss You can choose among three new bevel techniques: Smooth, Chisel Hard, and Chisel
Soft. Plus, you can apply textures, contours, and metallic effects, and you can more precisely control shading.

Click a style in the Styles palette
to apply it to objects. Select
options for how styles are listed in
the palette: as thumbnails or in a
text list. Even choose how compact or visible those items are.

Once you’ve designed a layer effect, you can save it as a layer style for future use. Layer styles work just like
unsaved layer effects, applying nondestructive changes that update automatically when you change a layer.
Photoshop stores styles in a default styles library file. You can also store styles in your own style libraries
using the Preset Manager. Those libraries are then available for single-click loading in the Preset Manager,
on the Styles palette menu, and in the context-sensitive tool options bar (when a vector drawing tool is
selected). Style libraries are portable, so you can share them with colleagues. Plus, Photoshop layer styles are
compatible with ImageReady—you can open a Photoshop layer style library in ImageReady, and vice-versa.
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Applying layer styles is easy: You can create text, shapes, and other objects, and then click a style in the Styles
palette to apply it. Or, you can select a vector drawing tool, choose a layer style from the context-sensitive
tool options bar, and start drawing. Photoshop then applies the style as you draw. The combination of layer
styles and the new vector-drawing tools opens up a wide array of creative opportunities for print and Web
designers alike—all while supporting streamlined, production-oriented efficiency.
Liquify command
With the new Liquify command in Photoshop 6.0, you can quickly distort or warp an image by interactively
pushing, pulling, rotating, enlarging, and shrinking different image areas. These distortion controls are ideal for
a wide range of tasks from making fine warping adjustments to a small image area to making sweeping adjustments for a wildly warped-out effect. When you open the Liquify window, you can display a fine mesh over the
image to help you achieve precise adjustments. To prevent unwanted changes, freeze certain parts of the image
and zero in on the areas you want to modify. To switch between largescale changes and finer adjustments, vary
the size of the brush you’re using. The Liquify command also provides options for reconstructing the original
image as needed.

Display the liquify mesh and then drag its vertices to adjust an image—for example, to fine-tune the
grimace on the biker’s face pictured here. Freeze areas of the picture that you want to preserve.

Enhanced PDF support
Photoshop 6.0 extends its integration with Adobe products by offering enhanced support for Adobe PDF,
including the ability to save duotones, spot-color channels, transparency, layers, and vector objects in PDF
files. In addition, you can annotate a Photoshop (PSD) file with voice or written comments and then export
the file and annotations as a compact PDF file for review. The other alternative is to distribute the PSD file
for review, but PDF files offer certain advantages. For one thing, PDF files are more compact than PSD files.
Plus, they can help ensure a smoother workflow because clients and colleagues can review a file without
having Photoshop installed (all they need is the free Acrobat Reader) and without worrying about accidental changes. You can also export image data and resolution-independent text and shapes in PDF files for
high-end output.
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Expanded 16-bit image support
Photoshop 6.0 is expanding its support for 16-bit images. For one thing, it can now handle 16-bit LAB
images and even convert them to other modes. In addition, you can now apply the following filters to 16-bit
images: Gaussian Blur, Add Noise, Median, Unsharp Mask, High Pass, Dust & Scratches, and Gradient Map.
The Canvas Size command is also enabled when you work with 16-bit images in Photoshop 6.0.

Produce superb Web graphics
Considered an essential tool by Web designers worldwide, Adobe Photoshop 6.0 is extending its Web toolkit
to include more timesaving, production-oriented features, including tighter integration with its advanced
Web production tool, Adobe ImageReady 3.0. Photoshop 6.0 now includes built-in slicing tools, so you can
slice Web images and output them directly from Photoshop or move them to ImageReady for more work.
Photoshop and ImageReady both offer dynamic layer-based slicing where the edge of the slice is bound to
the outermost pixel on the layer and adjusts automatically to any layer changes. New rollover styles, enhanced image map support, and weighted optimization controls all help you streamline Web production or
refine the visual results you can achieve on-screen. The integrated vector drawing tools and layer styles
presented in the previous section also contribute to faster creation of sophisticated Web graphics. Plus,
Photoshop offers tighter integration with Adobe’s premier Web authoring program, Adobe GoLive. This
section provides a brief overview of all of these exciting new Web features.
Slice tools
You can now slice Web graphics directly in Photoshop 6.0. (Previously, slicing tools were only available in
ImageReady.) Slicing images is the key to incorporating large or complex image files into your Web site
because Web browsers can download and display sliced images more quickly. In addition, sliced images give
you more control over how optimization options are applied because you can select separate slices and
apply appropriate settings. An image that includes solid colors, text, and photographic images, for example,
looks best with different settings applied to different areas. Once you’ve sliced an image, you can move it
into ImageReady to create rollovers or set up animations. Or, you can generate HTML pages directly from
Photoshop, including the HTML table code necessary to reassemble the sliced image.

Use the slice tools to slice images directly in Photoshop. Then apply separate compression settings to different areas—for example, apply GIF settings to text and
solid colors, and JPEG settings to photographic images. Also, move the sliced image
into ImageReady to set up rollovers and other advanced effects.
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With the slicing tools in Photoshop, you can now:
New slice tools in
Photoshop 6.0

• Create user-defined slices by dragging rectangles over different image areas with the slice tool. Photoshop
defines autoslices for the areas you don’t slice, so that it can generate an HTML table during export.
• Hide, show, lock, clear, and delete slices, as necessary.
• Select individual slices and apply different optimization settings to them in the Save For Web window. You
could, for example, apply GIF settings to areas containing text and solid colors, and assign JPEG settings to
image areas.
• Assign a file name, a URL link, an Alt tag, and a JavaScript message to each slice. URL links turn sliced
images into navigation maps. Alt tags replace image slices in non-graphical browsers. The JavaScript message appears in a Web browser’s status area. By default, the status area displays the assigned URL, but you
can change it to display any message you like.

Specify settings, such as a URL and
Alt tag, for each selected slice.

• Specify whether a slice is an image slice or a non-image slice. Non-image slices contain solid colors or
HTML text.
• Resize or reposition a selected image slice by specifying different W/H dimensions or X/Y positions.
• Rearrange the stacking order of slices.
• View or hide slice information on canvas and in the Save For Web window. Slice information includes the
slice grid and the identifying number assigned to each slice. (Note Like ImageReady, Photoshop automatically assigns every slice an identifying number starting in the upper-left corner of the image. Slices are automatically renumbered if you move them.)
• Use commands on a context-sensitive menu to affect slices directly.
• Generate a set of named image files and an HTML file with the table code necessary to reassemble the
image after you export the optimized file.

Context-sensitive menu
for adjusting slices in
Photoshop

• Produce high-quality HTML code that’s ready to be copied into Adobe GoLive or another HTML editor.
You control the code formatting, including indenting and whether tags are upper- or lowercase, so you can
match HTML coding standards.
• Control how Photoshop handles exported image slices, including specifying what it names them and where
it stores them.
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Saved slice sets
ImageReady provides all of the slicing controls that are available in
Photoshop, plus advanced controls for dividing, merging, duplicating, aligning, and linking slices. Now, with ImageReady 3.0, you can
also save multiple slices in named sets, so you can quickly select,
optimize, output, and even delete only those slices. Slice sets provide
a more efficient way to work with slices—you could, for example,
optimize and output only the image slices that contain interactive
Web buttons for use in your Web pages.

Save multiple related slices in sets, so you can easily
select, optimize, and output only those slices.

Dynamic layer-based slices
Photoshop introduces a new way to slice images: Set up effects on selected layers and then let Photoshop or
ImageReady generate layer-based slices for you. When you slice images this way, each slice is bound to the
outermost pixels on each layer. If you then reposition or edit the content of the layer, the slice adjusts dynamically to accommodate these changes. This technique is particularly useful for generating precise slices
for your JavaScript rollovers.
Original
slice 03

Slice 03 with a glow
effect applied

Use Photoshop or ImageReady to create dynamic layer-based slices for you. Then, if
you add an effect, such as a glow, the boundaries of the slice will adjust automatically
to accommodate the extra layer data (see slice 03 above).

Tighter integration with Adobe ImageReady 3.0
Adobe Photoshop 6.0 integrates more tightly than ever with its advanced Web-production component,
Adobe ImageReady 3.0. Now you can quickly jump back and forth between Photoshop and ImageReady
because file-saving happens automatically in the background. This smooth transition—plus the ability to
round-trip files flawlessly—ensures an efficient workflow. Like Photoshop 6.0, ImageReady 3.0 is designed to
be more intuitive to use. For example, when you select one of the new vector shape tools in the ImageReady
toolbox, all of the options that affect that tool’s behavior appear in one accessible context-sensitive tool
options bar.
ImageReady 3.0 also includes the new layer management controls, liquify command, and character and
paragraph options offered in Photoshop 6.0. For instance, you can create hundreds of layers in any image
and organize related layers in sets. And you can lock layers to prevent accidental editing. Alignment, leading,
hyphenation, justification, and indent settings can be applied to any paragraph, plus you can specify space
before and after paragraphs and produce typographically correct hanging punctuation. ImageReady also
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includes the new every-line composer for automatically setting optimal line breaks in a paragraph. Character-level controls let you apply color to each character, specify that a range of characters stay together (no
break), and so on. You can even warp text in ImageReady 3.0 as freely as you would in Photoshop 6.0.

New text character options
in ImageReady

New paragraph options
in ImageReady

ImageReady 3.0 also offers new creative options for your animations and rollovers: You can animate warped
text in ImageReady and even use a warped-text animation as a rollover. Plus, you can animate layer effects,
such as satins and gradients, with eye-catching results. For more details about enhancements to Photoshop
6.0’s interface, text controls, and layer management options, see “Master the power of Photoshop quickly”
later in this document.

Create, style, and warp text. Then turn text
into animations that warps in one direction
and then another. Even tween between
frames, so ImageReady can create intermediate warped steps.

Best of all, you can edit the text layers to
use different characters, text attributes,
and colors—without redoing the warp
settings or the animation. ImageReady
automatically handles the changes.

Rollover styles
ImageReady makes it easy to design rollover effects without having to know how to write JavaScript code. It
supports two types of rollover interactivity: You can design rollovers in which an image changes in a specific
area when a particular mouse action occurs there, or secondary rollovers where a mouse action in one area
causes something to happen in another area. A rollover can display simple effects, such as making a button
glow; cause one image to swap out with another; play back animations; and much more. You can use standard mouse actions, such as mouse-down, mouse-click, and mouse-over, to trigger a rollover, or define
custom actions to suit your Web design.

Design a rollover effect, and
then save it as a named
rollover style for later use.

Identify rollover styles by the little halftriangle in the upper-left corner.

ImageReady 3.0 introduces even more comprehensive rollover support:
Rollover states can now share color palettes to avoid distracting color
shifts. Dynamic layer-based slicing and expanded image map controls
enhance rollover creation. You can even preview rollovers directly in
ImageReady without having to launch a browser. Most importantly,
ImageReady 3.0 automates rollover production with the introduction of
rollover styles. When you design a rollover state that you want to use over
again or share with colleagues, save it as a rollover style in the Styles palette. All of the attributes of the rollover, including its effects, slices, and
states, are saved in the style. You can then apply the rollover style with a
click of your mouse to quickly produce interactive Web graphics.
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Weighted optimization
With the new weighted optimization controls in Photoshop 6.0, you can use 8-bit alpha channels to set
image optimization on a per pixel basis and smoothly vary compression settings across an image. This
means that you can produce higher-quality results in critical image areas without having to slice up an
image or handle the separate files that image slicing produces. What’s more, you’re no longer restricted to
the rectangular areas produced by slicing, but can optimize an image using the natural contours of different
image areas. Using channels, you can produce gradual variations in GIF dithering, lossy GIF settings, and
JPEG compression. Weighted optimization controls also let you favor colors in selected image areas as you
generate custom color palettes.

Use channels to vary your optimization settings across an image.
You can achieve a more exacting
balance between image quality
and file size with these settings.

New image map tools
in ImageReady

Enhanced image maps
You can create navigational image maps by using the new rectangle, circle, and polygon image map tools in
ImageReady to define hot spots and then associating URLs (Web addresses) with them. The image map
tools produce rectangular, square, circular, and freeform hot spots in images (the polygon tool produces
straight-edged freeform shapes). You can also set up dynamic layer-based image maps that adapt to changes
in the layer content. Once you’ve set up these hot spots, the image map select tool is available for selecting
and modifying them. For example, select a hot spot and then use the new Image Map palette to specify
different attributes, such as a URL link and an Alt tag for display in non-graphical Web browsers. The Image
Map palette also lets you control the precise size and location of your hot spots. Finally, use the slicing controls and Animation and Rollover palettes to assign rollovers to image map hot spots.

Define hot spots in your images. Then
select each one and assign a URL, an Alt
tag, and other settings.

Tighter integration with Adobe GoLive 5.0
Adobe Photoshop 6.0 and Adobe GoLive 5.0 integrate tightly to support your Web production process. Now
you can drop native Photoshop (PSD) files directly into GoLive without having to optimize them first in
Photoshop or ImageReady. Instead, you can use the built-in image optimization tools in GoLive to perform
those steps. Any URLs written by Photoshop or ImageReady are accessible in GoLive for management and
editing. You can even update edited URLs in the original PSD file.
You can also set up and slice a Web-page template in Photoshop and then drop it directly into GoLive where
you can continue working on it. If you resize an image slice, GoLive calls ImageReady to update the image,
so pixelation doesn’t occur. GoLive also goes back to the original Photoshop file to generate the final GIF or
JPEG file for the Web page.
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When exporting sliced images, Photoshop and ImageReady both generate a set of named image files and an
HTML file with the table code necessary to reassemble the image. (Alternatively, you can save sliced image
files as cascading style sheets.) The high-quality HTML code produced is ready to be copied into GoLive or
another HTML editor. Document-based settings let you control how the code is formatted, how image
slices are named, and where image slices are stored. You can, for example, control indenting and whether
tags are upper- or lowercase to match the HTML coding standards of different clients. When exporting
rollovers from ImageReady, select the Include GoLive Code option in the Save Optimized As dialog box for
optimal results.

Specify document-level settings that control
how the code is formatted, how slices are
saved, and so forth. These document-specific
settings give you the flexibility and control
you need to work with multiple clients.

Faster creation of Web graphics
The new vector-drawing tools in Photoshop 6.0 and ImageReady 3.0 (described in the previous section)
open new opportunities for Web designers. Now you can design Web buttons and navigation bars, or incorporate vector objects into your Web images, more
easily than ever before. In addition, the new layer styles
make it easy to create and store Web-oriented designs
for on-going Web graphics production. For more details, see “Superb Vector Shape Support” and “Layer
Styles” earlier in this document.
Additional preview controls
ImageReady 3.0 includes additional preview controls to
streamline your production process. Now you can click a
button in the ImageReady toolbox to instantly preview
the current file in your default Web browser. You can also
preview rollover effects in ImageReady without launching a Web browser.

Churn out handsome versions of standard
Web graphics in no time: Simply select a
vector-drawing tool and a layer style, and
start drawing.
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Enhanced contact sheets
Photoshop 6.0 includes a number of changes to make contact sheets more flexible. You can now define the
font size for labels on a contact sheet, choose among a variety of customizable templates with and without
HTML frames for the Web photo gallery, and select from predefined picture package templates that support
different page sizes. In addition, the picture package no longer adds borders around images, so the final
image sizes meet expectations.

Instantly generate a frame-based Web gallery of images using the
customizable Web contact sheet templates in Photoshop 6.0.

Master the power of Photoshop quickly
As the world-standard image-editing solution, Adobe Photoshop enjoys an unmatched reputation for innovation, power, precision, and stability. Today, its appeal extends beyond graphic design and into disciplines
such as medical research, law enforcement, zoology, and mathematics, where people are finding new ways to
apply sophisticated image-editing technology. This new customer landscape presents the challenge of how
to make the power of Photoshop more accessible to more people, while honoring the investment existing
users have already made in learning it.
Adobe Photoshop 6.0 rises to this challenge with a more intuitive interface design that helps you get up to
speed faster and dive into features more deeply. It includes hundreds of enhancements that reflect customer
feedback, workflow analysis, and years of Adobe’s own experience with the product. These enhancements
have been designed so that longtime users can assimilate the changes at a glance, enjoy newfound efficiencies, and even explore features they’ve never tried before. And new Photoshop users will find that power and
ease really can go hand in hand.
This section describes some of the key enhancements in Photoshop 6.0. It also introduces new ease-of-use
features, such as the context-sensitive tool options bar, on-canvas entry of text, expanded layer management
controls, and Preset Manager. For complete information about Photoshop 6.0’s refinements, see the Complete List of Photoshop 6.0 Enhancements document.
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The tool flyouts now
display the tool name
and shortcut key to
help you quickly
select the tool you
need for your task.

Streamlined interface
Adobe Photoshop 6.0 introduces numerous features designed to make it easier and more efficient to use its
powerful features. For example, you can organize frequently used palettes in a new palette well where they
are tucked out of your way but immediately accessible. A context-sensitive tool options bar provides more
direct and intuitive access to all of the options that control what you do with each tool. On the Windows
platform, the Open dialog box simplifies image selection with browsable thumbnails. The global setting for
your measurement system no longer prevents you from switching systems on the fly to make discrete
changes. An overview of these and other changes appears on the following pages: Browse here to see the
next generation of digital image editing in action.

Discover the full power of Photoshop at your fingertips.
Now, when you select a tool, all of the options that control its
behavior are easily accessible in a context-sensitive tool
options bar. For example, when you’re working with the new
vector-drawing or the selection tools, you’ll have access to
boolean operations, such as Add, Subtract, Intersect, and
Exclude, which were previously available only by keyboard
shortcut. And you can easily enter numeric values for the free
transform tool, or access the bounding box and specify
alignment options for the move and path component selection tools. The context-sensitive tool options bar is dockable
to the top or bottom of your screen, or you can let it float
anywhere on your screen.

Organize palettes in the convenient palette well.
With Photoshop 6.0, you can store the palettes you use
most often in a palette well, where they are readily available when you need them but out of your way when
you’re focused on a task. When you want to use a palette,
click its tab and the options immediately appear. Click
away again and the palette tucks up out of sight. (Note
that the palette well is visible only when the tool options
bar is positioned at the top or bottom of the screen and
your screen resolution is higher than 800x600.)

Switch measurements easily.
Now you can switch the unit of
measure for your rulers on the
fly. Just press Control (Mac OS) or
right-click (Windows) the rulers
and choose the unit of measure
you want from the contextsensitive menu that appears.
Plus, enter values in text boxes
using any measurement system—for example, specify 2
inches by 45 pixels for a rectangle you’re drawing.
Select context-sensitive
tools.
When you select any tool
in the toolbox, its related
options are automatically
available in the contextsensitive tool options bar.
Here one of the new
vector-drawing tools is
selected, so you can
immediately choose
whether to create a vector
shape, add a vector mask
to a layer, or paint pixels.
Plus, you can select a layer
style that will be applied as
you draw the vector shape.
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Faster access to images
Now you can locate and open images more quickly using Photoshop 6.0. You can, for example, find your
most recently opened files on the File > Open Recent submenu. (You also set the default for how many files
Photoshop lists here.) Photoshop remembers where you last opened or saved
files, so you can more easily access them in default locations. The Mac OS and
Windows versions of the Open dialog box also feature platform-specific
changes that streamline your file organization. For example, the Open dialog
box for the Mac OS lets you open multiple files, specify favorite folder locations,
and find files more easily.

Designate commonly used
folder as favorites, so you
can return to them quickly.

Browse image thumbnails in the Open dialog box.
Click Find to launch
Sherlock, which offers
extensive file and folder
search capabilities. Then
drag the find result you
want onto the Open
dialog box to select it.

A streamlined interface for brushes
In previous versions of Photoshop, brush options appeared in two different palettes: the Paintbrush Options palette
where you set blending modes, opacity, fade steps, and other options, and the Brushes palette where you selected default brushes to use. Now, in Photoshop 6.0, these options are all consolidated in one place—the context-sensitive tool
options bar. When you select the paintbrush tool, these options appear immediately, so it’s more intuitive what settings
are available and how they interact. Non-tablet users even have immediate access to pressure and fade settings that
control brush dynamics.
You can also edit brushes on the fly through a context-sensitive menu, adding them directly to
the brushes library on the tool options bar. Finally, the context-sensitive toolbar and the Preset
Manager give you one-click access to any brush libraries in the Brushes folder, so it’s easy to
load more brushes any time you need them without hunting through your hard drive. (For
details, see “Preset Manager” later in this document.)
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Brush dynamics options
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Resize the brushes library to make it wider or longer, so you can
more easily view and select brushes.
Create new brushes and instantly add them to the brush library
on the tool options bar. (You can also click a selected brush in the
tool options bar to reveal its settings, and then adjust those
settings and save a variation in a single click.)
Quickly reset, load, replace, and save brushes from the tool
options bar.
Specify how brushes appear on the tool options bar.
Open any brush library that’s saved in the Presets\Brushes folder
in a single click.
Specify settings to control brush dynamics.
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Additional usability
enhancements
Here’s a quick look at a selection of
other enhancements that will
make it easier to work in
Photoshop 6.0:
• The Save As and Save A Copy
commands have been merged,
so it’s easier to save your
Photoshop files to any file
format.
• Double-clicking or dragging
non-image files, such as
swatches, brushes, actions, and
layer styles, onto the application
quickly loads them for use.
• Choosing View > New Guide lets
you automatically place a guide
at a specified location.
• TWAIN device access is simplified—it’s no longer necessary to
specify the TWAIN source.
• Extended menu support means
that you can load more plug-ins
at once. In addition, you can set
a preference that automatically
directs Photoshop to load or not
load the plug-ins stored in the
Additional Plug-ins directory.
• Pressing Command+H or Ctrl+H
toggles the visibility of the
options set on the View > Show
submenu.
• Clicking once lets you quickly
find out why a current tool
shows the Cancel cursor.
• Maximum settings have been
raised significantly for a variety
of effects, such as Emboss,
Mosaic, Contract, Expand,
Smooth, Defringe, and Border.
You can also work with larger
layer effect sizes. For example,
you can now offset shadows as
much as 30,000 pixels.
• Photoshop 6.0 lets you check
files in and out of WebDAV
servers, so you can share files in
a collaborative environment
without fear of accidentally
overwriting files or losing file
updates.

Enhanced layer management
Layers are more flexible than ever in Photoshop 6.0. Now you can create hundreds of layers in any image to
help arrange different elements in an intricate composition (previously you were limited to 99 layers). Plus,
you can organize those layers into sets to keep better track of related parts. You can then toggle the visibility
of layer sets, hiding or showing them as you work; you can apply layer masks and layer clipping paths to
layer sets; and you can specify a layer set’s opacity.

Open a set to
reveal the layers
it contains. Note
the color coding,
which you can
apply to visually
identify associated layers.

Save layers in sets to
track them more easily.
Apply layer clipping
paths, layer masks,
opacity, and other
settings to affect a set
of layers.

Color-coding layers in the Layers palette lets you quickly identify layer relationships. Once your layers are
set the way you want, you can lock them to prevent accidental edits to image data, transparency settings,
and layer position. Or, lock layers before sending them out for colleagues and clients to review, so you
don’t have to worry about unexpected changes.
The enhanced Layers palette also helps you handle layer effects more efficiently. If you assign a layer effect
to one layer and want to reuse it on another, just drag and drop it in the Layers palette list. All of the settings are preserved and instantly applied to the target layer. Deleting layer effects is just as easy: simply drag
the effect to the Layers palette trash bin. Double-clicking a layer effect in the palette list opens the new
Layer Style dialog box where you can adjust the settings.

Drag and drop
layer effects
from one layer
to another in
the Layers
palette.

Those
effects are
instantly
applied to
that layer.

On-canvas entry of editable text
Here’s a new feature certain to please all Photoshop users: You can enter, style, and edit text directly on
canvas. Now you can see how your text looks in relation to your image without toggling back and forth in
the Type Tool dialog box. If you rotate, scale, or skew your text on-screen, the text remains editable. Text can
also be converted to editable outlines for use as masks or other vector elements if the fonts applied have
outline data available. When your text and image are ready, output them as crisp vector text and image data
in PDF files or directly to a PostScript printer or file. A PDF file can then be processed for high-end output
using Adobe Acrobat InProduction or other Acrobat prepress plug-ins.
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Enter and style vector text directly on canvas.

The text remains editable no matter how you change it.

Expanded text options
Extensive new text options are available for styling words and paragraphs. For example, you can freely twist
and warp text, which remains completely editable. Text options now appear in Paragraph and Character
palettes, which work similarly to those in Adobe Illustrator and Adobe InDesign. New paragraph options let
you specify alignment, autoleading, space before and after, hanging punctuation, and left-, right-, and firstline indents on a per-paragraph basis. Photoshop fully supports paragraph justification with options for
setting minimum, maximum, and desired values for word spacing, letter spacing, and glyph scaling.

New text character options
in Photoshop 6.0

New paragraph options
in Photoshop 6.0

The English version of Photoshop also provides professional-quality hyphenation settings with control over
the minimum word size, minimum number of characters before and after a hyphen, number of consecutive
hyphens, and hyphenation zone. Photoshop even supports the next generation of Adobe composition engines, offering you a choice of the every-line and single-line composers. The every-line composer sets multiple lines of text in relation to each other to ensure optimal line breaks, while the single-line composer
handles one line of text at a time.
With the new character controls, you can apply color on a per-character basis, scale characters vertically and
horizontally, set baseline shift, and automatically produce ligatures and oldstyle figures. Plus, Photoshop
fully supports OpenType fonts and their related features, such as all caps, small caps, superscript, and subscript. (Photoshop produces faux versions of these text options for non-OpenType fonts.) A new no-break
option controls whether or not a range of characters wrap as a single word.
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Photoshop also includes extensive CJK (Chinese, Japanese, Korean) formatting controls, including: Tsume
for manual kerning, Tate-chu-yoko for setting horizontal text within vertical text, Kinsoku shori for setting
word breaks, Burasagari for hanging punctuation, and Mojikumi for auto-kerning and justification.
ImageReady 3.0 supports all of the new text options in Photoshop 6.0, except for CJK formatting.

Twist and pull text using extensive built-in warping controls. Apply
color on a per-character basis.

Then freely edit the warped and colored text.

Preset Manager
The new Preset Manager centralizes management of your custom brushes, gradients, shapes, contours, patterns,
and layer styles, and it offers instant access to the extensive libraries of presets included with Photoshop 6.0.
When you create your own custom presets, you can easily save them in library files using the Preset Manager.
Those libraries can then be loaded at any time or shared with colleagues to streamline their creative work.
Save, delete, and load custom brushes, swatches
gradients, layer styles, patterns, contours, and
custom shapes in one centralized place.

Load preset libraries in a
single click if they’re stored
in the Presets folder. No
more hunting around your
hard disk!

Loading preset libraries takes only a click of the mouse because those libraries appear on a menu in the Preset
Manager if your library files are stored in their default locations in the application folder—for example, in the
Photoshop 6.0\Presets\Brushes folder. (In addition, preset libraries are available for similar one-click loading
anywhere they are used, including the context-sensitive tool options bar, the Styles palette, the Gradient Editor
dialog box, and other locations.)
The Preset Manager is resizable, so you can easily scan the content you’re loading. Plus, the Preset Manager
menu lets you choose how to view the content—in large or small thumbnails, in large or small text lists with
thumbnails, or as a text-only list. You can also double-click any brush, swatch, pattern, or other preset in the
Preset Manager, and assign it a name. For example, you could build a set of swatches for a Web project, and
assign names that tell you and your colleagues where to use them—such as “Background for logo” or “Main
page nav bar.” Those names would then appear in any text list. Once you open a library with the Preset Manager, it’s available for use in appropriate places, such as the context-sensitive tool options bar, the Layer Style
dialog box, and the content layer dialog boxes.
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Creating gradient and pattern presets
New interface enhancements streamline the creation of certain presets, such as gradients and patterns. For
example, you can now edit gradients on the fly to create new variations without affecting the original gradient, and then save those variations for future use. The Gradient Editor is resizable for easier viewing of
complex gradients, and offers interactive color and opacity stops, smoothness controls, and new options for
defining noise-based gradients.
It’s also easier to define and save patterns for later use (beyond the immediate Photoshop session). Photoshop
prompts you for a name when you
define a pattern and then includes the
pattern on the context-sensitive tool
options bar and in appropriate dialog
boxes. If you define a pattern without a
selection, Photoshop uses the entire
document as the pattern and assigns the
document’s name to it.

Easily save patterns for
on-going use.
Design noise-based gradients.

Annotation tools
It’s often challenging to communicate to clients
and colleagues all of the necessary information
for a smooth review process. That’s why
Photoshop 6.0 is incorporating annotation tools
that let you embed written design notes or recorded voice comments directly in your files. For
example, you could now organize design options
on different image layers, and then append notes
to those layers explaining how to review them or
providing other background information. The
annotated Photoshop (PSD) or TIFF file could
then be sent for review to anyone who has
Photoshop 6.0. Alternatively, you could save the
file as a PDF with the annotations and layers
preserved and send it out to be reviewed in
Adobe Acrobat or Acrobat Reader. Your colleagues and clients would then append their own
comments to the PSD, TIFF, or PDF file and send
them back to you for quick compilation.
Add written or recorded
comments to your
Photoshop (PSD) files. Then
distribute the PSD file for
review, or export the PSD
file to PDF for review in
Adobe Acrobat.

New annotation tools in
Photoshop 6.0
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Updated color management
Adobe Photoshop 6.0 introduces less restrictive color-management controls, which streamline configuration of a device-independent, color-managed workflow. These new controls are provided by the Adobe
Color Engine (ACE), the latest version of Adobe’s core color-management technology. All of the color management controls now appear in one dialog box for easy access, plus they come equipped with detailed
built-in Help. You can choose between advanced and standard modes depending on how much control you
want to exercise. Photoshop 6.0 provides preset workflows, so it’s easy to
switch among standard U.S. (SWOP), European, and Japanese prepress
settings and even among video and Web graphics defaults. Or, you can
set up your own custom workflow and save the settings for later use.
Photoshop 6.0 lets you set color management policies in advance or
decide every time you open a new file whether to discard, preserve, or
convert a color profile. It even offers better feedback on the ICC profiles
contained in the files you’re opening or saving. In addition, documentlevel controls mean that you do not have to convert files to the current
color working space. You’ll also find it easy to turn color management
off for those times when a color-managed workflow isn’t desirable.

Set up a color-managed workflow
using less restrictive controls.
Check the Advanced option to
exercise even more control over
your color management workflow.

The new ACE technology offers better integration with Adobe Illustrator 9.0, which includes the same engine, as well as with other upcoming
Adobe publishing products. This integration makes color management
easier to learn and ensures consistent color as you move files between
Photoshop 6.0 and Illustrator 9.0. For example, Photoshop and Illustrator now automatically detect when their color management settings
vary and prompt you to synchronize them to ensure better color
fidelity. Photoshop 6.0 also includes
built-in soft-proofing controls for
accurately previewing CMYK and
RGB images on-screen or on a
desktop color printer.

Use the Proof Setup controls to accurately preview RGB and CMYK images on-screen.

Enhanced crop tool
The crop tool now appears at the top level of the toolbox—instead of under the marquee selection
tools—where it’s more readily available to help you crop scanned images. In addition, the crop tool offers
enhancements that make it more intuitive to use. For example, when you define a crop area, it now dims
the area outside of the crop box, so you can visually check the crop and make any quick adjustments
before you complete the action.
The crop tool can also be used to transform the perspective of a cropped area, so you can repair a poorly
scanned image. To eliminate perspective effects, you simply define a nonrectangular region. Photoshop
automatically calculates the final cropped rectangular area based on the size and aspect ratio of the original picture. In addition, the Image > Crop and Image > Trim commands are enhanced, so you can work
with arbitrary selections including feathered ones; choose whether to hide or discard the cropped area;
and perform other cropping tasks.

Eliminate perspective effects by defining a nonrectangular crop
area. Photoshop automatically determines the final rectangular
cropped area. Note that the area outside the crop is dimmed to
help you check and fine-tune what you’re cropping.
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Extra Value in the Box
Here’s an overview of the extra
value you’ll find in the Adobe
Photoshop 6.0 software package.
• Adobe Photoshop software
plus these other useful
programs:
—Adobe ImageReady 3.0 for
advanced Web-production
tasks
—Adobe Acrobat Reader 4.0
software for viewing Portable
Document Format (PDF) files
—The Adobe SVG Viewer plugin for viewing SVG pages from
different Web browsers
—Tryout versions of other
Adobe software
—A variety of sample plug-ins
from third-party developers
• Adobe Photoshop 6.0 User Guide
• Adobe Photoshop 6.0 Quick
Reference Card
• An extensive new HTML Help
system, plus single-click access
to a rich selection of content on
Adobe.com, including Adobe
corporate news, Photoshop tips
& tricks, preset libraries, plugins, and more
• 100 royalty-free stock photos

Revised Extract Image command
First introduced in version 5.5, the Extract Image command provides accessible tools for masking intricate,
hard-to-define edges, which previously required painstaking manual work to mask. Photoshop 6.0 now
delivers an enhanced version of this command with new smart-highlighting, mask edge, and mask cleanup
tools that can help you achieve refined results. The process is simple: When you choose Image > Extract and
select the Smart Highlighting option, built-in edge detection technology in Photoshop helps you define the
image area you want to extract. After filling the area, you can click Preview to check the extraction or click
OK to see it directly in Photoshop. In Preview mode, the mask edge and mask cleanup tools are available for
you to smooth edges as necessary, automatically filling or erasing areas to produce the best results.

Quickly mask the original image
using smart highlighting. Then
interactively fine-tune the mask
edges using the new cleanup tool.

Original image

Extracted image

Expanded support for batch-processing files with actions
Photoshop 6.0 simplifies the batch-processing of files with revised options for opening and renaming files.
It also makes more tasks accessible to actions, such as specifying tool options, print and page setup parameters, and brush selections. You can even use sound annotations in your actions. In addition, you can automatically turn a currently selected action in the Actions palette into a droplet for batch operations. Then, to
trigger a batch action, all you have to do is drag a folder of images onto the droplet. You can even share
droplets across platforms to streamline batch production in a mixed-system workgroup. When a batch
operation saves out files, it can include the original document names, the date, serial numbers and letters,
file extensions, and other attributes in the final file names.
Tip
Photoshop 6.0 also provides
extensive soft-proofing controls
for proofing RGB and CMYK
images on-screen or on a desktop color printer before you
produce your final output. For
details, see “Updated color
management” earlier in this
document.

Print preview
Photoshop 6.0 helps you avoid printing surprises: Now you can open the Print Options dialog box to view
the image as it will appear in print, including printer’s marks such as crop marks, registration marks, captions, and labels. Plus, you can specify halftone screens and transfer functions. You can then drag the preview image to resize or reposition it on the page. Color management options are accessible from the revised
Print Options dialog box, so you can view the assigned ICC profile, choose an ICC profile for your proofing
device, and change the ICC profile for your output space. The Include Vector Data option controls whether
or not vector data is output with your image data.
Expanded File Format Support
Photoshop 6.0 now preserves layers in exported TIFF and PDF files and supports more compression options, including JPEG and ZIP, in its TIFF files. Photoshop also supports additional file formats, including
PBM, Wavefront RLA, and Alias PIX. A streamlined dialog box makes it easier to import PhotoCD images.
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System Requirements*
Mac OS
• PowerPC® processor
• Mac OS software version 8.5, 8.6,
or 9.0
• 64 MB of RAM* (with Virtual
Memory on)
• 125 MB of available hard-disk
space (after install)
• Color monitor with 256-color (8bit) or greater video card
• 800x600 or greater monitor
resolution
• CD-ROM drive
Windows
• Intel® Pentium® class processor
• Microsoft® Windows 98, Windows
2000, or Windows NT 4.0†
• 64 MB of RAM*
• 125 MB of available hard-disk
space (after install)
• Color monitor with 256-color (8bit) or greater video card
• 800x600 or greater monitor
resolution
• CD-ROM drive
* 128 MB required to run Photoshop
and ImageReady concurrently
† NT Service Pack 4, 5, or 6a required
Estimated Street Price
$609

Specify printer’s marks and preview how they will look
in the final printed output before you print.

Expected Ship Date
3rd Quarter 2000
* System requirements are subject
to change prior to the product
shipping.

Availability and pricing
In the United States and Canada, Adobe Photoshop 6.0 for Mac OS 8.5, 8.6, and 9.0, Windows 98, Windows
NT 4.0, and Windows 2000 is expected to ship in the third quarter of 2000. The estimated street price for
Adobe Photoshop is $609 (U.S.) for all platforms. Registered users of earlier versions of Adobe Photoshop
can upgrade to version 6.0 for only $199 (U.S.). This upgrade pricing does not apply to Limited Edition
versions. All retail and upgrade versions are available only on CD-ROM.
French, German, and Japanese versions are expected to be available after the initial release. Information
about other language versions, as well as all pricing, upgrade, and support policies for other countries, will
be announced separately.
Customers can call Adobe Systems at 800-492-3623 or visit the Adobe Web site at www.adobe.com for more
information.

About Adobe Systems
Founded in 1982, Adobe Systems Incorporated (www.adobe.com) builds award-winning software solutions
for Web and print publishing. Its graphic design, imaging, dynamic media, and authoring tools enable
customers to create, publish, and deliver visually rich content for various types of media. Headquartered in
San Jose, California, Adobe is the fourth largest U.S.-based personal software company, with annual revenues exceeding $1 billion.

Adobe Systems Incorporated
345 Park Avenue
San Jose, CA 95110-2704 USA
World Wide Web
http://www.adobe.com

Adobe, the Adobe logo, Acrobat, GoLive, Illustrator, ImageReady, InDesign, InProduction, LiveMotion, Photoshop, and PostScript are either trademarks of Adobe Systems Incorporated
either in the U.S. and/or other countries. Macintosh, Mac, Mac OS, and Power Macintosh are trademarks of Apple Computer, Inc., registered in the United States and other countries.
Intel and Pentium are registered trademarks of Intel Corporation. PowerPC is a registered trademark of International Business Machines Corporation. Microsoft, Windows, and
Windows NT are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries. All other trademarks are the property of their
respective owners.
© 2000 Adobe Systems Incorporated. All rights reserved. Printed in the USA. 06/00

